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Windows 10 Screen Capture Tools  
By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 

February 2019 issue, STUG Monitor - www.thestug.org / ndemarte (at) verizon.net 
 
The ability to capture an image of a whole computer screen or Window has been around since the 1960’s. 
It comes in handy for anyone who wants to include a portion of a screen, such as a picture, group of text, 
chart or graph, in another place. For example,  you might be typing a letter to a friend and want to include 
a map of your recent vacation trip from an online catalog. You can open both the letter and the page that 
contains the map. Using a capture tool, you can snip (capture) just the map and paste it into the letter.  
 
The original capture tool was the Print Screen key (PrtScr) on the keyboard. At first, this basic tool could 
capture only the content of the whole screen or an active 
Window. You can still find Print Screen on most keyboards as 
one of the F keys along the top, but to use it in Windows 10, you 
must first enable it. Click Start > Settings > Ease of Access > 
Keyboard (in left pane near the bottom) > Print Screen Key. Turn 
on “ Use the Print Screen key to open screen snipping.”  
 
Windows currently offers three capture tools. 
  
1. Snipping Tool  was introduced in 2002 as part of the Microsoft Tablet PC. In 2006, it became 
one of the accessories in the VISTA operating system.  Besides the basic captures of Windows 
and screens, it added freeform captures and editing tools like colored pens and an eraser. It also 
added a time delay of 1 to 5 seconds to give the user time to open a menu which would otherwise 
not be visible during the capture. 
  
Snipping Tool captures are saved as photos (.jpg files). They can be copied into MS Paint for more 
extensive editing. Once saved and edited, they can be pasted into the Office apps, such as Word 
documents, Excel spreadsheets, Outlook emails, or PowerPoint presentations.  
 
2. Screenshot  was introduced in 2017 in the Word, Excel, PowerPoint, and Outlook 
applications. It is a newer version of the Print Screen key and is located on the Insert tab in the 
Illustrations or Images group. It can capture the whole screen, a Window, or a portion of a 
screen or Window. Detailed instructions for its use can be found by holding your mouse pointer 
over the Screenshot icon, then clicking Tell Me More. 
 
3. Snip and Sketch  is the newest Windows 10 capture tool, which was part of the Fall 2018 
Windows update 1809. It has all the features of Snipping Tool plus a few new ones to 
accommodate the features of current devices, such as touch screens. It has a ruler and a 
protractor to use if a capture needs to be a specific dimension. Its time delay choices are 3 or 10 
seconds.  
 
Snip & Sketch also lets you crop the snip before leaving the app. A capture can be shared with nearby 
devices using Bluetooth and Wi-Fi.  In Windows 10, pressing the enabled Print Screen key will open the 
Snip & Sketch mini toolbar, or you can open it by pressing the Windows key + Shift + S. 
 
As a longtime fan of Snipping tool, I was concerned when I learned that it will be replaced soon by Snip & 
Sketch. However, Snipping Tool will still be available at no cost in the Microsoft store. The more I use Snip 
& Sketch, the more I find it to be a good upgrade, but I’m keeping them both among my apps until I decide 
which is my favorite. Everyone needs a capture tool. 
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CES 2019 
By George Harding - Tucson Computer Society - January 21, 2019 

 
There were 180,000 attendees, 4500 vendors and some 500 qualified press. 
 
Press events: Unveiled (150 vendors), Digital Experience (250 vendors), ShowStoppers (200 vendors), 
press conferences all day Monday. 
 
Notable items: More IoT and AI, plus 5G, 4K and OLED, autonomous cars, VR and AR 
(VR means "Virtual Reality". AR means "Augmented Reality.) 
 
The Internet of Things (IoT) is several years old now and has been used to allow operation of one or more 
devices remotely with one controller, usually a smartphone. Ex., lights, thermostat, garage door, etc. 
 
Now IoT has been widely expanded to allow remote control of all devices with one controller. The goal 
appears to be to hook everything to everything else. 
 
Artificial Intelligence (AI) is the use of computer programs to decide to take specific actions when defined 
circumstances occur, i.e. to cause apparently intelligent actions 
 
One device that is a combination of AI and IoT is Footloose, a cat waste disposal device. But it’s more 
than that. It also analyzes the waste to identify possible illness, dispose of the waste hygienically, checks 
cat’s weight how often it uses the device, how long it spends there and how much it leaves behind. It can 
identify multiple cats (if you have more than one). It’s also self-cleaning and odorless, using NASA 
technology. There’s also a smartphone app. 

 
 
Another example is a food-ordering system, perhaps set up in a public place, like an apartment lobby. You 
select your choices and the food is delivered into your cubicle. Again, a smartphone app is part of the 
system. 

 
AI has tremendous potential and has already been used by many companies to speed up business 
operations.  
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The 60 Minutes program last Sunday talked with a Chinese entrepreneur investing in AI startups. They 
have 140 of them so far, 10 being worth $1 billion already. He says “Intelligence” is a misnomer, since 
these programs cannot think like a human and will never be able to do what humans can do. 
 
5G is the latest generation of cellular mobile communications. It brings higher data rates, lower latency, 
higher system capacity and massive device connectivity (per Wikipedia). It is expected to allow much 
faster cellphone service, and much broader coverage. AT&T, Sprint and Verizon have already 
demonstrated 5G in limited locations. General availability is expected in 2020. 
 
TV innovation is slowing, leading to ubiquitous inclusion of 4K and OLED. There is 8K on the horizon, but 
little in the way of source material. 
 
Organic Light Emitting Diode (OLED) is created with a film of organic compound that emits light in 
response to electric current. This technology provides excellent color response, referred to as HDR, with 
blacker blacks and whiter whites. It also provides a much thinner TV unit, typically 3/4ths of an inch thick. 
 
As usual, there were many car makers with their concept models. Autonomy is getting more widespread 
and the devices are being incorporated into the design, rather than strapped on top and side.  

 

There was an autonomous VTOL helicopter from Bell.  
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Hyundai Elevate helps first responders access very difficult areas.  

 
See video at https://youtu.be/A33Yu-9rgxo 
 
Drones continue to increase in ability and decrease in price. DJI is the leader in the industry currently. 
Their lowest price drones are Mavic and Spark 

 
The rotors of the Mavic fold inward, making a very compact device to carry. 
 
The increased speed of computer chips and the sophistication of devices has made VR more widespread, 
being used in companies for training, repair and more. AR is still not widespread. 
 
Kodak showed a very small, compact projector, Luma, which can project to an 8-foot screen. 

 
 
All in all, CES is a mammoth event that shows what is being provided today and will be provided 
tomorrow by companies that serve the consumer market. 
 
CES is presented in early January each year. See their web site at www.ces.tech  
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Interesting Internet Finds April 2019  
By Steve Costello - scostello (at) sefcug.com 

 
In the course of going through the more than 300 RSS feeds, I often run across things I think might be 
interesting to other user group members. The following are some items I found interesting during the 
month of March 2019.  
 
Can I Use My TV As A Second Display? 
https://askleo.com/can-i-use-my-tv-as-a-second-display/ 
 
Leo Notenboom answers this often-asked question. 
 
5 Useful Mobile Apps To Help You Deal With Long Layovers 
https://www.maketecheasier.com/useful-mobile-apps-for-long-layovers/ 
 
My wife and I are flying a lot more often since we have both retired. If you fly a lot also and end up with a 
lot of layovers, check out this post for making those layovers less stressful. 
 
3 Tips For Caring For Your Eyes When Using Technology 
https://www.dailybits.com/3-tips-for-caring-for-your-eyes-when-using-technology/ 
 
Whether you are young or old, wear eyeglasses or don’t, you need to know these tips if you use 
technology. 
 
How Does DuckDuckGo Protect Your Personal Information Online? 
https://www.makeuseof.com/tag/duckduckgo-protect-personal-information-online/ 
 
If you are not using DuckDuckGo as your search engine, I recommend that you do. This post explains 
how it protects your personal information online. (Note: I also use the DuckDuckGo app on my 
smartphone and tablet.) 
 
Why You Should Stop Using Mobile Data 
https://www.computerworld.com/article/3379616/why-you-should-stop-using-mobile-data.html 
 
After reading this post, I turned mobile data off on my smartphone for the weekend. Instead of checking 
Twitter, Gmail, etc., all the time, I was able to just enjoy the day without interruption. I was able to use the 
phone and text functions without any problems. The few times I did want to get to the internet I was able 
to through Wi-Fi either at home or nearby shops. (I am thinking that I will keep mobile data off unless I am 
traveling and need to use the internet a lot.) 
 
How To Pack Your Electronics For Air Travel 
https://www.howtogeek.com/407341/how-to-pack-your-electronics-for-air-travel/ 
 
For those not used to flying with electronics, This post explains how you should pack them to avoid 
problems. 
 
HTTPS Everywhere — Make The Internet A Safer Place 
https://www.wonderoftech.com/https-everywhere-extension/ 
 
I use this extension all the time in my browsers. I like that I don’t have to keep checking for “https” all the 
time. If you don’t already use this, read the post and install it in all your browsers, set it up, and be safer 
easily. 
 
********** 
This work by Steve Costello is licensed under a Creative Commons Attribution 4.0 International License. 
As long as you are using this for non-commercial purposes, and attribute the post, you can use it in part, 
or whole, for your newsletter, website, or blog. 
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Kretchmar’s Korner - Printer Problems 
By David Kretchmar, Computer Hardware Technician, Sun City Summerlin Computer Club, NV 

January 2019 issue, The Gigabyte Gazette - www.scscc.club/Tomburt89134 (at) cox.net 
 
Printers are the most problematic piece of computer equipment, next to the 
computers themselves. Just like computers, you can’t live with them and you can’t 
live without them. Even if you’ve decided you can live without a full computer and 
have moved to a tablet or maybe just your smartphone, there are still going to be 
occasions when you want to have a “hard copy” (printed copy) of a document. Also, 
with the multi-functionality of most printers today, most of us have gotten used to 
the convenience of having a photocopier, scanner, and maybe even a FAX 
machine in our homes. 
 

It’s easy to understand why printers are such a pain; there are so many moving parts and opportunities for 
something to go wrong. Fortunately, you can address many printer problems using the techniques I’m 
going to describe. If none of the following work, it is probably time to bite the bullet and invest in a new 
printer. If something mechanical is shot in a printer, the fix is often prohibitively expensive (just buying 
some new printer heads can cost over $100).  

The USB connection 

Unless you’re using a printer wirelessly, you need a working USB connection 
between your computer and your printer. Sometimes a wireless connection is 
necessary, such as when printing from a cell phone, tablet, or from a computer 
not proximate to the printer. But if you are printing from a computer adjacent to 
the printer, a wired USB connection is always more reliable and highly 
recommended. Most of us know how to connect the standard USB male 
connector to our computer, but there is more confusion with the other end of 
that USB cable that attaches into (usually) the back of the printer (see the 
picture to the left). 

 
Unfortunately, the printer end of the USB cable also fits into the similar looking telephone line connection 
on the printer. Usually there is a pair of these female telephone line connectors on printers that include 
FAX capability; at least one will often be covered with a plastic cap.  
 
One way to tell if you are using the USB connection on the printer is to listen for the USB “handshake” 
tone from the computer. If both your printer and computer are on, you should hear a couple of notes when 
you plug in or remove a USB device. If not, most likely you have missed that USB connection on the 
printer. Be especially aware of this possibility if you are setting up a printer new to your system, or if for 
some reason the cable has become disconnected from your printer. It is rare for the USB cable to go bad, 
but I have seen this on occasion. 

Drivers can drive you crazy 

The printer and the computer must be able to communicate with each other, and this is accomplished with 
specialized software known as drivers. Windows 10 has printing drivers for most of the newer printers 
available today, but I strongly suggest installing the drivers 
furnished by the computer’s manufacturer. This is especially true 
if you want to do more than print, i.e. if you want to scan a 
document into a file. A new printer will usually come with a CD 
that can be used to load the drivers appropriate for your 
operating system. If you have a tablet or other device that does 
not include an optical drive you can go the printer manufacturer’s 
website, i.e. hp.com/support, and download and install the 
appropriate drivers. If you have a choice between downloading 
the basic or full featured software package, I suggest downloading 
the full featured package then doing a custom install, installing 
only the software you will be using. For whatever reason the full 
featured software package sometimes works when the basic 
package does not.  
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Manufacturers will often keep their website drivers more up to date, fixing bugs that have appeared after 
the printer has been on the market for a while. So, if you are having issues with your printer it’s a good 
idea to download drivers from their website. 
 
When you do the custom install of your printer software, I suggest you deselect features such as the 
customer participation programs and supply ordering programs. I would also pass on the free optical 
character recognition (OCR) program, unless this is something you will use. OCR programs can be a real 
resource hog. 
 
After the driver installation and a reboot see if any new programs are loading automatically by seeing if 
there are any new icons appearing on the right side of your taskbar. If so, you might want to open 
MSCONFIG and stop these programs from loading on startup. If you get a popup asking if you want low 
ink notifications immediately or “only when printing”, select “only when printing”, so this program will not 
be running constantly. 
 
If you are buying a printer to use with a wireless device such as a Kindle Fire, Smartphone or iPad, do 
some research and make sure you are getting a printer that is supported by your device.  
 
As you might expect with the popularity of the iPad, many printers will support the iPad with a free 
download from Apple. I’ve noticed that especially newer Hewlett Packard wireless printers are made to be 
compatible with the iPad.  
 

 

SD Card Readers 
Review of presentation by Susan Malloy, Secretary, Northern Neck Computer User Group, NY 

Review by George Cadmus - December 2018 issue, The Computer Link 
www.nncug.org - geocadjr (at) verizon.net 

 
At a recent NNCUG meeting, Susan showed and explained an SD card reader that she uses. A memory 
card reader is a device that can read flash memory cards and transfer their contents to a computer. Flash 
memory cards come in various types and formats, providing removable storage for digital equipment like 
camcorders, cameras, MP3 players and cell phones. There are single and multiple card readers, and 
while the former can only read a single memory card type, the latter can read a variety of formats. 
 
Without a memory card reader, a person has to directly connect the physical device that uses memory 
cards to the computer. This is usually done with a Universal Serial Bus (USB) or Firewire cable. The 
advantage of a reader is that memory cards can be read directly on the computer without attaching the 
device. This greatly simplifies using, storing and organizing the cards. It also saves batteries and wear 
and tear on the camcorder or other digital device. 
 
It is common for people to own more than one device that uses flash memory cards, with each device 
using a different type of card. A multiple card reader will accept a variety of formats, making it useful for 
all of your memory card needs. These readers commonly feature two or more slots to accept different 
sized cards. Some memory card readers are extremely compact, barely larger than the cards they read. 
These plug directly into the USB port and are about the size of a memory stick. Others are designed to be 
internally installed into a free bay on desktop computers, with an array of choices between these two 
models. One advantage of the external model is that it is portable, able to be used with multiple 
computers and/or laptops in the household.  
 
Many newer computers, including many laptops and notebooks, have a card reader built-in by default. 
Printers and even some monitors may have them as well, so that the information on the cards can easily 
be printed or displayed. Anyone who has been thinking about replacing an aging desktop, laptop, printer 
or monitor, might look into these options first.  
 
When buying a reader, consumers should be sure it supports the type of card(s) required. This includes 
the card's capacity in addition to the format. Some models might not read flash memory cards larger than 
1 GB, for example. Shoppers should also bear in mind too that a more flexible card reader that supports 
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additional formats might make the device a little more future proof in the event that they acquire more 
digital devices later or replace the ones they already own.  
 
Memory card readers are typically extremely affordable, and they can be found at many online retailers 
and local suppliers of computers and digital equipment.  
 
To see a video on SD card readers, click on the link. https://binged.it/2C6fUDg  
 
 

Taming E-mail 
By Dick Maybach, Member, Brookdale Computer User Group, NJ 

www.bcug.com - n2nd (at) att.net 
 
Like many others, I rely on e-mail as my primary means of communication, and almost every day I deal 
with messages that are important to me. The problem of course is to sort them out from the deluge of 
those that are not. My e-mail vendor does a good job of removing most spam, but still much of what I do 
see is unimportant. Today I’ll be discussing strategies to make the important messages more accessible 
than those that are less so. The implementation details will depend on how you access your mail, in 
particular whether through a Website of with a client program on your PC. 
 
Back in the communications-by-paper era, common advice to improve your efficiency was to touch 
documents on your desk only once. That is, deal with them the first time you see them. Today the 
equivalent advice is to move messages from your e-mail inbox the first time you read them. For most 
messages this is read-and-delete, but you will probably want to file a few, such as those with purchase 
receipts. Touch-once is a goal, but for me at least, an unattainable one. However, by working toward it 
you will be improving your efficiency. 
 
I use the Thunderbird e-mail client program, which has a message filter feature. This scans fields in each 
incoming message, looking at the sender, subject, body, age, size, etc., and acts according to their 
contents. Each can be deleted, put in a folder, marked as read, etc. Most e-mail clients and Webmail 
sites have similar tools. 
 
If you correspond with only a few, you might classify as spam all messages except those on an OK list, 
such as your address book. You will probably have to check the spam folder fairly regularly to be sure 
you don’t miss something important. This strategy wouldn’t work for me is as I run an organization’s 
Website and sometimes get questions from its members. I do want to see these, even though I may 
never have communicated with the senders. Instead, I accept all messages except those that meet 
specific criteria. 
 
I have found that most forwarded messages are unimportant, and many are frivolous. As a result, all 
messages with subjects beginning “Fwd:” are immediately sent to the FWD folder. I do look here every 
day or so, because these are often from friends, although almost never do they require a response, and I 
don’t want pictures of cute animals cluttering my inbox. 
 
There is also an Ads folder, and incoming mail from many merchants immediately goes there. This isn’t 
spam, as I do deal with the senders and will again, but some send me several messages a week, and I 
have no need to deal with them immediately. Of course, it takes a while to develop a set of filters. When I 
get a new ad, I have to decide if this is likely to be frequent enough to make it worthwhile to define a filter. 
Every day or two, I do scan through the Ads folder in case there is something interesting (there seldom is) 
and delete everything else. 
 
My ISP does a good job of filtering spam before I see it. Sometimes too good, I occasionally find valuable 
messages in the Website spam folder. 
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Most e-mail programs have a feature similar to what Thunderbird calls the message filter. For example, 
Figure 1 shows the filter to file forwarded messages. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1. FWD Message 
Filter. 

 
As you can see, any message whose subject contains “Fwd:” is sent to the local folder FWD. Note that 
some fields are drop-down lists. For example, Figure 2 shows the alternate choices to these. As a result 
you have considerable flexibility in setting up your filters. 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2. Alternate Choices for Subject, contains, and Move Message to.  
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Figure 3 shows the AT&T Webmail screen to define an E-mail message filter, which has features similar 
to Thunderbird’s. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 3. AT&T E-mail Message Filter Definition. 
 
So far, we’ve discussed diverting messages from the inbox, but you probably also want to organize the 
storage of mail you’ve read but need to retain. For this purpose I’ve created folders to collect those 
messages, such as BCUG, Finance, Medical, Orders, Personal, and Travel. This makes them easier to 
locate than if they were somewhere in my inbox. 
 
Every so often, I delete most of the old messages, regardless of in which folder they reside. Once I’ve 
returned from a trip, I really don’t need its boarding passes, and once an order is delivered, I don’t need 
its tracking number. 
 
Periodically, check the server, even if you download all your messages to client software on your PC. You 
may find a valuable message in its spam folder. It’s also a good idea to clear out old messages, as 
occasionally there are reports of ISP break-ins. You may feel you have nothing to hide, but they probably 
contain details of your life you don’t want in the wrong hands. 
 
You most likely use e-mail differently than I do, and you probably use different tools to manage it, but you 
probably also get dozens of messages each day, making it worth taking a little time to develop an 
appropriate strategy to deal with them efficiently. 
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Open Source Lab - The End is Near (for Windows® 7) What about Linux? 
By Cal Esneault, former President of and leader of many Open Source workshops 

February 2019 issue, CCCC Computer News- www.clickers.org - tsa70785 (at) gmail.com  
 
Traditionally, Microsoft Corp. released a new Windows operating system version every 3 years and 
supported each version for 10 years. The very popular Windows 7 release will reach the end of extended 
support on January 14, 2020 (next year!). Although many PC users have switched to Windows 10, over a 
third of PC users are still running Windows 7. If you still have Windows 7 and do not want to purchase a 
new computer, you could upgrade to Windows 10 for a fee (~ $139), but you also need to consider your 
PC capability. I have found that you need something newer than a Core Duo processor and 4 GB of RAM 
if you want an acceptable speed. 
 
Many casual users today have discovered that smartphones and tablets meet their browsing and 
communication needs. To continue to use a less capable PC for special needs, now may be a good time 
to consider switching to a Linux system available at no cost. At our club, we suggest Linux Mint with the 
Cinnamon desktop. It is a modern graphical system with lots of similarity to Windows 7. In addition, it 
comes pre-loaded with lots of free software covering most basic needs (see screenshot below). 
 

 
 
If the pre-loaded programs don’t meet your needs, there are thousands of additional applications available 
at no cost using the supplied software manager (see screenshot below). 
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To verify that Linux will work on your equipment, you can make a “live” USB or DVD drive as a test 
without making any changes to your existing installation. First, install from the Internet a suitable program 
to make the “live” drive (for example, “Rufus”). Then, download a 64-bit “iso” of the latest Linux Mint. 
Using the downloaded utility, install the Linux system on the detachable hardware. With the Linux drive 
attached, at start-up immediately switch to the BIOS menu (search the Internet to find the proper key to 
press) and change the boot order to load the live system first. 
 
After boot, you will be running Linux using your attached drive (no interaction with your existing system). 
You can test your hardware at this point and evaluate the Linux system. Upon shutting down, remove the 
temporary drive. Then reboot back into Windows 7 and consider your future options. 
 
 

Don’t ever share your password or pin # 
By Jerry Heaton, Editor, Central Kentucky Computer Society 

December 2018 issue, CKCS Newsletter - www.ckcs.org - newsletter (at) ckcs.org 
 
The importance of protecting your personal information has been stressed time and again. Yet we still 
hear of occasions where someone has fallen for a scam which has cost them money, time and much 
aggravation. 
 
I would like to think no one in our group has fallen for a scam of any type that cost them money. But I 
would almost bet someone I know has become a victim. I don’t know it and probably never will because 
victims don’t like to admit their stupidity – maybe that is a harsh word let’s just say for being such a ‘soft 
touch.’ 
 
Most people become victims only when they believe someone person convinces them they have a great 
chance to make some easy money or perhaps save them a lot of money.  
 
I offer only a few rules which you should follow to keep from becoming a scam victim. 
 
1. Don’t answer or linger on the phone with a caller you don’t know – even if they are from your own area 

code. Scammers and hackers can be anywhere in the world and still use you home area code. 
2. If your phone rings once and then hangs up. DO NOT call back thinking the call was important and 

just got dropped. It could be their intent is to get you on the line and involve you in a lengthy 
conversation with the goal to keep you online as long as possible. There are area codes in the 
Caribbean that charge many dollars per minute which can be added to your phone bill. 

3. If your phone rings and your caller ID shows someone you don’t know – don’t answer the call. If you 
decide to answer the call and don’t recognize the voice – hang up 

 
Should you do decide to ignore the above suggestion, and answer a call – more rules: 
1. Don’t trust anyone who calls with a great deal for you, which seems almost too good to be true – it 

likely is too good to be true. 
2. Never ever give anyone your password – no one needs to know that but you. 
3. Never ever give anyone your pin number – no one needs to know that but you. 
4. Never ever give anyone your banking information – no one needs to know that but you. 
 
All this discussion came to mind as a CKCS board of directors member Jan Landers sent me the follow 
scam notice to put in the newsletter this month. It credits no individual or location, nor does it identify the 
author. The scam though is new to me and seems plausible. Just remember, this story may be new and 
true, or maybe not, It begins: 
 
Alert your family and friends. Just when you thought you'd heard it all. Beware of people bearing gifts. 
 
The following is a recount of the incident from the victim: 
Wednesday a week ago, I had a phone call from someone saying that he was from some outfit called: 
"Express Couriers," (The name could be any courier company). He asked if I was going to be home 
because there was a package for me that required a signature. 
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The caller said that the delivery would arrive at my home in roughly an hour. Sure enough, about an hour 
later, a uniformed delivery man turned up with a beautiful basket of flowers and a bottle of wine. 
 
I was very surprised since there was no special occasion or holiday, and I certainly didn't expect anything 
like it. Intrigued, I inquired as to who the sender was. 
 
The courier replied, "I don't know, I'm only delivering the package." 
 
Apparently, a greeting card was being sent separately. (The card has never arrived!) There was also a 
consignment note with the gift. 
 
He then went on to explain that because the gift contained alcohol, there was a $3.50 "delivery/
verification charge," providing proof that he had actually delivered the package to an adult (of legal 
drinking age), and not just left it on the doorstep where it could be stolen or taken by anyone, especially a 
minor. 
 
This sounded logical and I offered to pay him cash. He then said that the delivery company required 
payment to be by credit or debit card only, so that everything is properly accounted for, and this would 
help in keeping a legal record of the transaction. He added, "Couriers don't carry cash to avoid loss or 
likely targets for robbery." 
 
My husband, who by this time was standing beside me, pulled out his credit card, and the "delivery man," 
asked him to swipe the card on a small mobile card machine with a small screen and keypad. 
 
Frank, my husband, was asked to enter his PIN number and a receipt was printed out. He was given a 
copy of the transaction. 
 
The guy said everything was in order and wished us good day. 
 
To our horrible surprise, between Thursday and the following Monday, $4,000 had been 
charged/withdrawn from our credit/debit account at various ATM machines. 
 
Apparently the "mobile credit card machine," which the deliveryman carried now had all the info 
necessary to create a "dummy" card with all our card details including the PIN number. 
 
Upon finding out about the illegal transactions on our card, we immediately notified the bank which 
issued us a new card, and our credit/debit account was closed. 
 
We also personally went to the police, where it was confirmed that it is definitely a scam because several 
households had been similarly hit. 
 
WARNING: Be wary of accepting any "surprise gift or package," which you neither expected nor 
personally ordered, especially if it involves any kind of payment as a condition of receiving the gift or 
package. Also, never accept anything If you do not personally know or there is no proper identification of 
who the sender is. 
 
Jan, the board member who sent me this added this comment, “Above all, the only time you should give 
out any personal credit/debit card information is when you yourself initiated the purchase or transaction! 
 
No doubt you might think of another rule or two that should be added to this list to protect ourselves. 
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Six Little Word Problems and their Solutions 
By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 

November 2018 issue, STUG Monitor - www.thestug.org / ndemarte (at) verizon.net 
 
You print a multi-page Word document and get an unexpected blank page at the end of the document. 
Because it has a footer, you won’t be able to use that sheet for anything except scrap paper. 

 
Solution: Before you click  Print, press the Show/Hide key on the Home tab > Paragraph group and 
scroll or press the Ctrl+End keys to get to the end of the document. You will see one or more 
paragraph icons on the last blank page.  Select them and press Delete. Then save the document to avoid 
the blank page in future printings. 
 
2. You open a document and find you have to squint to see the small type.  
Solution: Go to the Zoom slider at the bottom right of the screen and click 
the + sign a few times until the document text is large enough to be 
comfortable for your eyes. This will not affect the text size when printed. 
 
3. You are just about done typing a Word document and notice that all the text in 
the last couple of sentences is in upper case. You had pressed the Caps Lock key 
on the keyboard accidentally.  
 
Solution: First select the text you want to reformat. Then click the Change Case tool 
(Aa) on the Home tab > Font group. Click the case pattern you want from the list, 
which in this situation is probably “Sentence case.”  
 
 
 
4. Sometimes you forget what version of Windows you have on your computer. “Version” includes the 
operating system (Windows 7, 8.1, or 10) and the Windows update version number, such as the recent 
update, 1803. But you’re not sure how to find the answer. 

 
Solution: To find the version of your Windows operating system, type in the Search box at the bottom left 
of the taskbar the word winver . Then click the winver run command to see your computer’s details. 
 
 
 
 
 
5. When you enter an email or web address in a document, by default Word automatically adds a 
hyperlink to the address. You can identify a hyperlink by its 
blue text and underline. Many times, you don’t want the 
hyperlink included. 
 
Solution: There is a way to change the setting to stop the 
automatic hyperlink from being added.  
 
Click the File tab (top left of the ribbon), then click Options 
(last item on the menu). Click Proofing > AutoCorrect options 
> Autoformat and uncheck the last item on the Replace list, 
“Internet and network paths with hyperlinks,” then click OK.   
 
Just to be safe, also click “Auto Format As You Type” 
and uncheck the same box there, followed by OK. 
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While you are in the Word 
AutoCorrect area, check to see if 
you are being bothered by any 
other automatic action. If so, 
uncheck it and click OK. 
 
 
 
 
 
 
 

If you change your mind, return to this screen and re-check the boxes. 
 
6. You have typed a long list of items, such as book titles, taking up several pages of a Word document. 
Each title is on a separate line. You would like to find out how many items there are in the list, but 
counting them would be tedious. 
 
Solution: Select the entire list using Ctrl+A. Then on the Home tab - Paragraph group, click the numbering 
tool (top row, second from left) to place a number in front of each item. Then press Ctrl+End to jump to the 
end of the list, where you can view the last number. If you wish, then press Ctrl+Z or Undo to remove the 
numbering. 
 
 


